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CHAPTER 1

Introduction
Doc-To-Help's workspace uses a modern Multiple Document Interface (MDI), and gives you options
to work the way that you want.
The interface incorporates the following:
n

"Doc-To-Help Menu in Word" on page 6

n

"Navigation Panels (Word)" on page 36

n

"Options Dialog" on page 60

n

"Ribbons" on page 17

n

"Window Panes" on page 65
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CHAPTER 2

Doc-To-Help Menu in Word
A Doc-To-Help project can be opened directly in Word. When you click the File menu in Word, the
Doc-To-Help menu is now available. This is the initial menu for Doc-To-Help that will display when
you create a new project or open an existing project.
This chapter discusses the following:
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Getting Started
The Getting Started submenu allows you to do one of the following when you select the
Open/Create section:

Function

Description
Opens an existing Doc-To-Help project in Word.

Opens the wizard to create a new Doc-To-Help project.

Opens a sample Doc-To-Help project in Word. This may be helpful to review
the structure of an existing project before creating your own project.
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Help
The Help section of the Getting Started submenu gives you access to the following Doc-To-Help features in Word:

Function

Description
Open the embedded help system for Doc-To-Help.

Open the Doc-To-Help home page.

Visit MadCap's online forum to interact with other Doc-To-Help users.

View and download PDF manuals for Doc-To-Help.

Watch tutorial videos on Doc-To-Help.
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Function

Description
Report any errors or issues you encounter while using Doc-To-Help to MadCap
Technical Support.

Check to see if any updates are available to download for Doc-To-Help.

Deactivate Doc-To-Help from your workstation.
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Common Tasks
The Common Tasks submenu allows you to configure your options and settings, schedule builds,
compact the size of your Doc-To-Help project and convert older versions of Word documents to the
current version.
NOTE: The Common Tasks submenu will only display when you have a Doc-To-Help project
already open.

Function

Description
Configure file locations, preferences, and SharePoint options.

Schedule builds for your Doc-To-Help project.

Choose a specific name to save your Doc-To-Help project.

Shrink the size of your project.
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Function

Description
Import settings from an XML file or existing Doc-To-Help project.

Export settings to an XML file or another Doc-To-Help project.

Convert older versions of Word documents to the current version.
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OPTIONS
The Options dialog allows to you to configure file locations, preferences, and SharePoint options.

Notice that the General tab has a new section for Build options. The bottom option is new for this
release.
When that option is checked, the Build Log will automatically display while the build for your Doc-ToHelp project is in progress.

BUILD SCHEDULER
Using the Build Scheduler, you can schedule and monitor automatic builds of targets. One-time,
daily, and weekly builds can be scheduled.
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Reports
The Reports submenu through Word will display all of the reports available for your Doc-To-Help project.

Following are the available reports:
n

Help Contents Listing Displays the table of contents for the target chosen with all books
expanded and all topics visible.

n

Help Index Listing Displays all the project’s index keywords and how many topics are assigned
to each one.

n

Index Report by Group Displays a list of associated topics, if any. Groups are listed in alphabetical order.
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n

Index Report by Keyword Shows a list of associated topics, if any. Keywords are listed by full
path name in alphabetical order.

n

Index Report by Topic Shows a list of associated keywords and groups, if any. Topics are listed in alphabetical order by title.

n

Script Listings Lists the code for each script defined in the project. Scripts are listed in alphabetical order.

n

Style Definitions Lists the properties of each style defined in the project. Styles are listed in
alphabetical order.

n

Topic Detail Report Lists the properties for each topic in the project. Topics are listed in alphabetical order by title, and each topic starts on a new page.

n

Unindexed Topic Report Lists each topic that is not associated with an index element
(keyword or group). Topics are listed alphabetically by title, along with their document name
and style from which the topic was derived.
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Team Authoring
This is how the Team Authoring submenu displays in Word:

You can manage the following components of your Doc-To-Help project if you intend to bind this
with a shared repository:
n

Connect to Team Project Connect to or open a shared Doc-To-Help project. See the online
Help or the Managing Your Project Guide.

n

Share Project for Team Authoring Select a repository type to be used to share the current project. See the online Help or the Managing Your Project Guide.

n

Disconnect Project from Team Authoring Stop sharing your Doc-To-Help project. See the
online Help or the Managing Your Project Guide.

n

Web Repository Settings Review and configure your existing repository settings. See the
online Help or the Managing Your Project Guide.
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n

Get Latest Version of the Project Synchronize your local and shared Doc-To-Help projects.
See the online Help or the Managing Your Project Guide.

Once your Team Authoring project is open, you can access the Team Authoring panel for more functions to help manage this project. See the online Help or the Managing Your Project Guide.
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CHAPTER 3

Ribbons
There are specific Doc-To-Help ribbons that are accessible in Word templates and documents associated with a Doc-To-Help project.
This chapter discusses the following:
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Ribbons in Word for Doc-To-Help Purposes
You can add multiple Microsoft® Word source documents to your project, and within those you can
add many kinds of elements and objects. Some features (e.g., images, lists, tables) are built into
Word and therefore always available, whether the document is part of a Doc-To-Help project or not.
But there are other features that are unique to Doc-To-Help (e.g., conditions, image maps, inline
text, variables). When you open a Word source document that is part of a Doc-To-Help project, you
will notice three additional ribbons displayed for using the unique elements of Doc-To-Help: Doc-ToHelp, Target, and the Project ribbons.
Depending on the source template you used to create the document, a ribbon called "Doc-To-Help
Special Formatting" may also be available.
NOTE: If you want to use the Special Formatting ribbon in your source document, be sure
to select the D2H_SMAL.dotx, D2H_SMAL_A4.dotx, D2H_NORM.dotx, or D2H_NORM_A4.dotx template when creating a new document. If your source document is using a different
template, and you switch to one of these four templates, the Special Formatting ribbon will
not be available.
For documents where this ribbon is not available, use the Bullet, Numbering, and Table buttons in
Word's native ribbons.
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In addition to Doc-To-Help's special Word ribbons, the Doc-To-Help Project panel lets you add other
unique elements to your source documents, such as links to variables, keywords, and topics.
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Dynamic Add-In Modes
When you open a document in Word, Doc-To-Help uses an add-in to determine what commands are
necessary for the type of document you opened. Depending on what kind of document you opened,
Doc-To-Help's Word add-in will open in one of three different modes. The Doc-To-Help ribbon
adjusts dynamically based on your document type and you will only see the functionality applicable
to the document you are working on.
The add-in will search for the document in Doc-To-Help projects and then open in one of the following modes:
n

No Features This mode is used for templates; new, unsaved documents; and documents with
an unsupported format.

n

Basic This mode is used when the document is not included in any Doc-To-Help project, the
add-in is disabled, or the add-in cannot find the Doc-To-Help project associated with the document. This mode is also used for final output.

n

Full This mode is used for all documents included in a Doc-To-Help project.

EXAMPLE—NO FEATU RES MODE
This document is a template. You do not need Doc-To-Help functionality for this document, so the Doc-To-Help Word add-in opens in No Features mode. It is the same as if
you opened Word without using the Doc-To-Help add-in.
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EXAMPLE—BASIC MODE
This document was opened in Word but is not included in a Doc-To-Help project. The
Doc-To-Help Word add-in opens in Basic mode, so you can make simple changes to the
document using the Doc-To-Help ribbon.
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EXAMPLE—BASIC MODE, PROJECT OU TPU T
This document is a finished Manual output built from Doc-To-Help. The Doc-To-Help
Word add-in opens in Basic mode. This is because you do not want to do heavy editing
in the finished output, but you might want to make some minor changes or notes using
the features in the Doc-To-Help ribbon. You can also create PDF output from the Word
document using the Doc-To-Help ribbon.
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EXAMPLE—FU LL MODE
This document is included in a Doc-To-Help project. The Doc-To-Help Word add-in
opens in Full mode, and you can use all of the functionality in the Doc-To-Help ribbon.
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NOTE: The Word add-in will search for projects in the following locations, in this order:
1. Open Doc-To-Help projects
2. Existing Doc-To-Help projects in the same folder as the opened document
3. Existing Doc-To-Help projects in the parent folder as the opened document
If more than one project is found, a dialog will open and you can select the appropriate project. The project you select will be remembered as the default for the document.
If you open a document from the Sharepoint server (not the local copy), the Doc-To-Help
project won't be found automatically. You must open the document separately for Doc-ToHelp to find the project.

NOTE: When an existing document is added to a project, the Word add-in will run in Basic
mode or Full mode, depending on the settings you choose. By default, the document is
copied into the project folder; if you leave this recommended default setting, the Word addin in the original document will still run in Basic mode, and the copied document now in your
project will run in Full mode. If you do not select to copy the document to the project folder
(i.e., you leave the document in its original location), the add-in in the original document will
switch to Full mode.
If an existing document is removed from a project, the Word add-in automatically switches
to Basic mode.

NOTE: If you rename (Save As) a document in Word, the add-in will try to find a Doc-To-Help
project that contains a file with that name. If it cannot find a project, the add-in will switch
to Basic mode.

NOTE: The Special Formatting ribbon is only available in Full mode.
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NOTE: The Word add-in is supported by Word 2010 and higher. It supports *.doc, *.docx,
*.docm, and *.rtf files.

NOTE: If the add-in is disabled, you will not be able to use the Doc-To-Help ribbon. A prompt
will alert you if the add-in becomes disabled. You can turn this prompt on or off from the
Options dialog.
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Doc-To-Help Ribbon
The following commands are available in the Doc-To-Help ribbon when it is opened in Full mode (see
"Dynamic Add-In Modes" on page 20).
Icon

Description
Rename or delete an existing topic in a document, or add a new
topic. See the online Help or the Documents, Templates, and Content Guide.
Apply the Heading 1, 2, 3, 4, or Body Text style to the selected text in
the source document. See the online Help or the Making It Look
Good Guide.

Create a hotspot link to topics containing the selected keywords, to
a group of topics, to a bookmark in a document, or to a link tag. See
the online Help or the Making It Look Good Guide.
Create a hotspot that will display additional text on the same line, in
a dropdown, or in a popup. See the online Help or the Making It Look
Good Guide.
Designates a hotspot as an index keyword. See the online Help or
the Making It Look Good Guide.

Designates a hotspot as a member of a group. See the online Help
or the Making It Look Good Guide.

Designates a hotspot as a link target. See the online Help or the
Making It Look Good Guide.
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Icon

Description
Sets a subset of the topic properties. See the online Help or the
Making It Look Good Guide.

Used to mark text as conditional by platform, target, attribute, or
any combination of all three. See the online Help or the Making It
Look Good Guide.
Creates a hotspot to a text or rich content variable. See the online
Help or the Making It Look Good Guide.
Creates a section that is either collapsed or expanded by default.
See the online Help or the Making It Look Good Guide.
Removes custom formatting created in the selected text. See the
online Help or the Making It Look Good Guide.
Apply a Doc-To-Help style on the selected text. See the online Help
or the Making It Look Good Guide.
Insert a note or image in the left margin of a printed target. The margin note can be displayed as a popup in online outputs if desired.
See the online Help or the Documents, Templates, and Content
Guide.
In online outputs, use the Image Map Editor to create hyperlinks
within an image. See the online Help or the Documents, Templates,
and Content Guide.
You may insert multimedia (video and audio) into online outputs.
See the online Help or the Documents, Templates, and Content
Guide.
Insert HTML Help ActiveX Controls into your Word documents. See
the online Help or the Documents, Templates, and Content Guide.
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Icon

Description
Insert cross-references that will appear as page numbers in printed
outputs and hyperlinks in online outputs. See the online Help or the
Documents, Templates, and Content Guide.
Add terms to your glossary from any Word source document. See
the online Help or the Documents, Templates, and Content Guide.

View the current Doc-To-Help version number.

CHAPTER 3

28

Special Formatting Ribbon
The Special Formatting ribbon is only available in Full mode when using the D2H_SMAL.dotx, D2H_
SMAL_A4.dotx, D2H_NORM.dotx, or D2H_NORM_A4.dotx templates.
NOTE: If you want to use the Special Formatting ribbon in your source document, be sure
to select the D2H_SMAL.dotx, D2H_SMAL_A4.dotx, D2H_NORM.dotx, or D2H_NORM_A4.dotx template when creating a new document. If your source document is using a different
template, and you switch to one of these four templates, the Special Formatting ribbon will
not be available.

Apply a list style to the selected text in the Word source document.

Insert a table in your Doc-To-Help project. See the online Help or the Documents, Templates, and
Content Guide.
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Target Ribbon in Word
Targets can be added, built, and published within this ribbon.
The Active Target for your Doc-To-Help project can be set to any target that you have already created in your project. The Target Properties button allows you to add, edit or delete any targets.
The targets can be built ad-hoc or by scheduling a build. You can also Rebuild your target or schedule your target to be rebuilt. The build of the active target can be viewed, or you can cancel an ongoing build. Once the target has been built, you can view the Build Log, or Publish to Sharepoint.
The default themes of your targets can be modified. You can also add a new theme using the Wizard or Designer.
Your Templates are also managed in this ribbon. Use the Target Template button to change your
default template of your project. You can also Add, Edit, or Remove templates.
The following functions can be performed on the Target ribbon:
Icon

Description
Select the current target for your Doc-To-Help project.

Modify the settings of your active target.

Build the currently selected active target. If you click the drop-down
arrow, you can also schedule a build for your active target.
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Icon

Description
Rebuild your target. Similar to the Build button, you can also schedule a Rebuild for your target.

Cancel an ongoing build.

View the PDF of your output if you have a printed manual target.

Publish your output to a SharePoint repository.

View the log file of the most recent build. You can also click this button to hide the window pane for the build log.

Select a theme for your active target.

Add a new theme for your target.

Launch the Theme Wizard to walk you through creating a new
theme.
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Icon

Description
Open the Theme Designer so you can customize your theme.

Select the template for your output.

Add a new template for your target.

Edit the existing template selected for your target.

Remove the existing template.
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Project Ribbon in Word
Settings for your Doc-To-Help project can be modified in this ribbon. You can also apply attributes
and styles to your Doc-To-Help project.
The Topics Panel is displayed through the Project ribbon. When you click on this button, it displays
each of the topics.
Templates are now added and managed through the Project ribbon.
The Team Authoring functions are available once your Doc-To-Help project has been committed to
a shared repository such as TFS, a file system repository, or web repository.
The following functions can be performed on your Doc-To-Help project through the Project ribbon:

Open the Doc-To-Help Project panel. You can use this panel to access some of Doc-To-Help's
most frequently used functions without having to leave Word. This panel includes five window
panes: Documents, Contents, Index and Groups, Variables, and Related Topics.

Use this button to select a project that contains the active document. Or you can add the active
document to another Doc-To-Help project.

Review and configure your existing settings of your Doc-To-Help project.
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Click this button to display the Topics window. You can also click this button to hide this window.

Set an attribute-based condition for the selected document. The document will be included or
excluded when creating conditional builds (e.g., internal or external.) Use the Attributes dialog to
create custom attributes. See the online Help or the Documents, Templates, and Content Guide.

Customize the default window display types. See the online Help or the Documents, Templates,
and Content Guide.

Modify the default paragraph and character styles as currently set by your source template. See
the online Help or the Making It Look Good Guide.

Automatically create the index based on one or more topic types or styles. Open the drop-down
menu to set preferences. See the online Help or the Documents, Templates, and Content Guide.
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Create or add existing documents to your Doc-To-Help project. See the online Help or the Documents, Templates, and Content Guide.

The template currently selected for the open Word source document is displayed at the bottom of
this section. You can change the look of the output, edit, or remove the source template. See the
online Help; the Documents, Templates, and Content Guide; or the Making It Look Good Guide.

Use this section to share or synchronize a Doc-To-Help project bound to a repository. See the
online Help or the Managing Your Project Guide.
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CHAPTER 4

Navigation Panels (Word)
You can use these panels to view output from your targets; see build status; and work with source
documents, topics, keywords, and variables.
This chapter discusses the following:
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Doc-To-Help Build Output Panel
The Doc-To-Help Build output panel allows you to view and troubleshoot build outputs directly from
Word. A progress bar and percentage indicator in the bottom right corner of the panel will also display build progress. Additionally, if there is a build error or unresolved link, you can view the errors
from this panel.
The panel will split into tabs (at the bottom of the panel) as the specified target builds. One tab is the
Build Log; the other displays the Error(s) and Unresolved Link(s) (if any). On the Build Log tab, click
the Open build log link to open a text version of the build log.
The Errors and Unresolved Links tab displays detailed information so that you can troubleshoot the
issues found during the build. Right-click in the panel for options to change the column display or
sort. Click the Errors, Warnings, or Unresolved Links buttons to sort by each of these error types.
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HOW TO OPEN THE DOC-TO-HELP BUILD LOG PANEL
1. In Word, select the Target ribbon.
2. In the Project section, select Build Log. The Build Log is displayed.

NOTE: You can also configure Doc-To-Help to automatically display the build log for each
build. Go to File > Doc-To-Help > Common Tasks > Options > General and check the option
for Display Build Log automatically for each build.
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Doc-To-Help Progress Panel
The Doc-To-Help Progress panel displays build status messages and build progress percentages
when the Doc-To-Help Build panel (see "Doc-To-Help Build Output Panel" on page 37) is not open.
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HOW TO ENABLE THE DOC-TO-HELP PROGRESS PANEL
By default, the Doc-To-Help Progress Panel opens when a build is initiated. If it does not display, do
the following:
1. Select File > Doc-To-Help > Common Tasks > Options. The Options dialog opens.
2. Select the General tab.
3. In the Prompts section, select Display Progress Panel in all open Word documents during
build.
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Doc-To-Help Project Panel
The Doc-To-Help Project panel allows you to access some of Doc-To-Help's most frequently used
functions . This panel includes five window views: Documents, Contents, Index and Groups, Variables, and Related Topics.
n

Documents You can use the Documents window view to add and create new documents for
your project. Documents can be converted to HTML5 format if you wish. You can also
rename, remove, view and open all of the source documents that are part of the current DocTo-Help project, and create links to these documents. See "Documents Window View (Word)"
on page 47.

n

Contents You can use the Contents window view to view and edit the table of contents (TOC)
for the active target. You can modify the TOC if your project uses target-specific tables of contents for a specific target. You can also use this window pane to create links to the topics in
your project. See "Contents Window View (Word)" on page 43.

n

Index and Groups Keywords and secondary keywords can be added in this view, and they can
also be renamed or removed. You can use the Index and Groups window view to view all of
the available index keywords and groups in the project, and to create links to these keywords
and groups. See "Index and Groups Window View (Word)" on page 50.

n

Variables Window Pane You can use the Variables window view to create and display all the
text and rich content variables available in your project, and to create links to these variables.
See "Variables Window Panel (Word)" on page 55.

n

Related Topics Pane This view allows you to manage your related topics, groups, and subtopics. You can create the related topics links easily by dragging-and-dropping individual topics from the Topics Panel into the Related Topics pane. See "Related Topics Window View
(Word)" on page 58.
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HOW TO OPEN THE DOC-TO-HELP PROJECT PANEL
1. Select the Doc-To-Help ribbon.
2. In the Project section, select Project Panel.

NOTE: The Project Panel opens by default when you open a source document in Word that
is part of your Doc-To-Help project.
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Contents Window View (Word)
You can use the Contents window pane to view the table of contents (TOC) for the current project.
If your project uses target-specific tables of contents, you can select the target from the drop-down
at the top of the window pane.
The table of contents shows all of the topics in the active target. You can expand or collapse the list
of topics using the
and
buttons in the local toolbar. Double-click any entry to quickly jump to
that topic. If the topic is in a source document that is not open, the document will open in a new
instance of Word.
Use the directional arrows to move highlighted topics up or down in the order of your TOC. You can
also use the left arrow to promote a subtopic, or the right arrow to make a highlighted topic a subtopic.
You can create a new book in the TOC, rename or remove a topic in the Contents view. This view
allows you to rebuild your TOC after you have finished your updates.
You can also drag entries from the Contents window pane to the current document to create links.
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HOW TO OPEN THE CONTENTS WINDOW VIEW
1. In Word, select the Doc-To-Help ribbon.
2. In the Project section, select Project Panel.
3. In the Project Panel, select Contents.
Button

Description
Expand the list.
Collapse the list.
Filter the contents by entering a search string in the line below when you click this
button.
Rearrange your topics.
Rebuild your TOC based on your document structure (Doc-To-Help’s automatic
TOC).
Create a book.
Rename a topic/book.
Remove a topic/book.
Designate the displayed TOC as target specific. (Choose the target using the Active Target button on the Target ribbon.)
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NOTE: If you make changes to your project that affect items in the Doc-To-Help Project
panel (e.g., adding a variable, adding an index keyword), the Doc-To-Help Project panel will
update to reflect these changes.
In general, changes to topics also update as you make them. However, you will have to build
your project to see changes in the Contents window pane if either of the following is true:
n

Your project has not yet been built (in which case the Contents window pane will be
empty until you build).

n

Your project uses target-specific tables of contents.
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Documents Window View (Word)
You can use the Documents window view to review and open all of the source documents that are
part of the current Doc-To-Help project. Double-click a document to open it in a new instance of
Word.
The Documents view allows you to add and create new documents for your project. You can also
rename or remove a document from your project.
Use the directional arrows to rearrange, promote, or demote the order of your documents in this
view.
You can use the
button to filter the Documents view. Enter your criteria in the search bar that
appears below when you click on the Filter button.
You can drag documents from the Documents window view to the current document to create a
D2HML link to another topic.
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Button

Description
Expand the list.
Collapse the list.
Create a new document. See the online Help or the Documents, Templates, and
Content Guide.
Add an existing document. See the online Help or the Documents, Templates, and
Content Guide.
Convert documents to HTML5. See the online Help or the Documents, Templates,
and Content Guide.
Rename a document.
Remove a document from the project.
Rearrange your documents.

HOW TO OPEN THE DOCUMENTS WINDOW PANE
1. In Word, select the Doc-To-Help ribbon.
2. In the Project section, select Project Panel.
3. In the Project Panel, select Documents.

NOTE: The Project Panel opens by default when you open a source document in Word that
is part of your Doc-To-Help project.

NOTE: If you make changes to your project that affect items in the Doc-To-Help Project
panel (e.g., adding a variable, adding an index keyword), the Doc-To-Help Project panel will
update to reflect these changes.
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Index and Groups Window View (Word)
You can use the Index and Groups window view to review all of the available index keywords and
groups in the project. Click

(default) in the toolbar to display the project keywords (Index); click

to display the project groups. You can expand or collapse the list of index keywords using the
and

buttons. See the online Help or the Documents, Templates, and Content Guide.

In this view, keywords and secondary keywords can be added, renamed, or removed.
When you click on the
button, you can view the Groups of keywords that have been created in
this project. You can then add, rename, or remove Groups.
You can drag index keywords or groups from the Index and Groups window view to the current document to create links. Select the word you want to use as a keyword, then drag the keyword from
the keyword from the window pane to the document. To apply multiple keywords or groups to a
selection, hold down the SHIFT or CTRL key, then select the items you want to link.
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When you click on the Groups button, the local toolbar switches so that you can add and modify
keyword groups in the view below.
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BUTTONS—KEYWORDS TOOLBAR
Button

Description
View index keywords.
View groups.
Expand the list.
Collapse the list.
Filter the contents by entering a search string in the line below when you click this button.
Add a new keyword.
Add a secondary keyword.
Rename a keyword.
Remove a keyword.

BUTTONS—GROUPS TOOLBAR
Button

Description
Filter the contents by entering a search string in the line below when you click this button.
Add a new group.
Rename a group.
Remove a group.
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HOW TO OPEN THE INDEX AND GROUPS WINDOW PANE
1. In Word, select the Doc-To-Help ribbon.
2. In the Project section, select Project Panel.
3. In the Project Panel, select Index and Groups.

NOTE: The Project Panel opens by default when you open a source document in Word that
is part of your Doc-To-Help project.

Button

Description
View index keywords.
View groups.
Expand the list. (Keywords toolbar only)
Collapse the list. (Keywords toolbar only)

NOTE: If you make changes to your project that affect items in the Doc-To-Help Project
panel (e.g., adding a variable, adding an index keyword), the Doc-To-Help Project panel will
update to reflect these changes.
In general, changes to topics also update as you make them. However, you will have to build
your project to see changes in the Contents window pane if either of the following is true:
n

Your project has not yet been built (in which case the Contents window pane will be
empty until you build).

n

Your project uses target-specific tables of contents.

NOTE: Keywords and groups that have a checkbox next to them were created using the
Index and Groups window pane in Doc-To-Help.
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Variables Window Panel (Word)
Variables allow you to manage content in one place for reuse across your project. See the online
Help or the Documents, Templates, and Content Guide.
You can use the Variables window view to view the rich content variables and text variables available in your project. To open the rich-content variable document in a new instance of Word, doubleclick a variable or the variables document. Hover over a text variable to view additional information
in a tooltip.
The lower section displays all of your text variables. The local toolbar in this section has buttons that
will let you add text, version or date/time variables to your project. You can also modify or delete any
of these variables in this section.
You can drag variables from the Variables window view to the current document to add them to the
document.

CHAPTER 4

55

CHAPTER 4

56

HOW TO OPEN THE VARIABLES WINDOW PANE
1. Select the Doc-To-Help ribbon.
2. In the Project section, select Project Panel.
3. In the Project Panel, select Variables.

NOTE: The Project Panel opens by default when you open a source document in Word that
is part of your Doc-To-Help project.

NOTE: If you make changes to your project that affect items in the Doc-To-Help Project
panel (e.g., adding a variable, adding an index keyword), the Doc-To-Help Project panel will
update to reflect these changes.
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Related Topics Window View (Word)
Use the Related Topics window view to review and edit your related topics. You can view related topics three ways: by the hierarchy (TOC) structure, by keyword (index) entry, or by group.
Clicking on a topic, group, or keyword in the upper half of the Related Topics window view will display related topics in the lower half. See the online Help or the Documents, Templates, and Content
Guide.
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Button

Description
Expand the list.
Collapse the list.
Filter the contents by entering a search string in the line below when you click this button.
Display topics in a hierarchy (TOC) structure, as well as their related topics.
Display groups, as well as their related topics.
Display index keywords, as well as their related topics.
Disable subtopic relations.

RIGHT-CLICK
You can right-click on a topic in the Hierarchy to do the following:
n

Change the sort to By Document or Alphabetical

n

Disable Subtopic Relations

n

Expand All topics

n

Collapse All topics
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CHAPTER 5

Options Dialog
This dialog lets you choose miscellaneous global settings. To open this dialog you must first have a
Doc-To-Help project already open. Then, select File > Doc-To-Help > Common Tasks > Options.
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GENERAL
Field/Section
Prompts

CHAPTER 5

Description
Set various confirmation prompts.
n

Confirm editing properties of multiple topics If you select more than
one topic in the Topics window, and then click the Doc-To-Help ribbon > Topic Properties button, you will be reminded that you will be
editing the properties for all selected topics.

n

Confirm adding documents outside source document folders If
adding a document to your project using drag-and-drop, you will be
informed if the document is not stored in the correct folder. You
should always copy documents to the correct folder before adding
them so that the links don't break and the project is self-contained.

n

Confirm using Windows System colors If you change the System
background color for a JavaHelp or NetHelp target, you will be
informed that system colors are specific to Windows and explain
how this will be handled for the target.

n

Prompt installing Microsoft Help Viewer target after build If you
built a Microsoft Help Viewer target, you will be asked if you would
like to install the target. If yes, it will open the Help Library Manager
so you can add the project to the Microsoft Help Viewer and look at
it.

n

Prompt viewing help target after build After every build or rebuild,
you will be asked if you would like to view the target.

n

Prompt if Word add-in is disabled on startup If this option is selected, you will be alerted if the Word add-in has been disabled for DocTo-Help. If the add-in is disabled, you will not be able to use the DocTo-Help features in Word. You will be able to re-enable the add-in
from the prompt (you can also re-enable the add-in manually from
the Word Options dialog). You can also navigate to C:\Program
Files (x86)\MadCap Software\DocToHelp on your computer, and
run D2H.EnableWordAddIn.exe to enable the add-in.
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Field/Section
Build

Description
n

Display Progress Panel in all open Word documents during build If
this option is selected and 1) you start building a new target while
the Doc-To-Help Build panel is closed OR 2) you start building a new
target and close the Doc-To-Help Build panel, the Doc-To-Help Progress panel opens automatically in all open Word documents for
this project. This panel displays build status messages and build progress percentages.

n

Display Build Log automatically for each build This will display the
build log at the bottom of Word while the build is in progress if this
option is enabled.

FILES
Field/Section

Description

Default location for
Doc-To-Help projects

Change the default location for Doc-To-Help projects.

User-defined themes
location

Change the default location for Doc-To-Help custom themes. See the
online Help or the Making It Look Good Guide.

TEAM
Field/Section

Description

Highlight new project
items

Change the default "new project" colors for your team projects.

Checkout

Set Check Out options. See the online Help or the Managing Your Project
Guide.
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SHAREPOINT
Field/Section

Description

Default when opening
shared Word documents

Change the defaults for opening shared Word documents (open local
copy, open document on server, or prompt to open document on
server).
For more information about SharePoint, see the online Help or the
Managing Your Project Guide.

Check out Word documents when editing
local copy

When selected, Word documents will be checked out of the SharePoint
Library automatically when you open them in Doc-To-Help.

Synchronize Word documents with
SharePoint Library

Change the defaults for synchronizing Word documents with the
SharePoint library (when document is opened, saved, or closed).

Synchronize all shared
documents with Library

Change the defaults for synchronizing all shared documents with the
SharePoint library (when target is built).

UPDATES
Field/Section

Description

Check for latest DocTo-Help version

Select whether or not you want to check for updates when Doc-To-Help is
opened. If you want to check for updates automatically, and a new version
of Doc-To-Help is available, the Doc-To-Help Update dialog will open. The
update number and new feature list will be displayed. Click Download to
download the update.
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VIEWERS
Field/Section

Description

Location of the
Eclipse executable

Specify the location of the Eclipse executable file (eclipse.exe) on your
machine. Doc-To-Help requires this information to view Eclipse Help.

EPUB reader executable

Specify the location of the EPUB reader executable on your machine.
Doc-To-Help requires this information to view EPUBs.

Use the following version of Microsoft Help
Viewer

Specify the version of the Microsoft Help Viewer to use when viewing
Microsoft Help Viewer targets. Options available depend on your Visual
Studio installation.

CHAPTER 5

64

CHAPTER 6

Window Panes
Word has a couple of window panes that are displayed depending upon on the task.
This chapter discusses the following:
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Team Authoring Window Panel (Word)
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Topics Window Panel (Word)
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Team Authoring Window Panel (Word)
The Team Authoring panel only appears when you open a team project. See the online Help or the
Managing Your Project Guide.
This panel displays all of the document names in the repository, as well as their status, modification
date, and the date they were retrieved from the repository.

TEAM AUTHORING PANEL
Once have you opened your Team Authoring project, you can access additional related functions for
this project. Select the Project ribbon and click the Team Authoring button to view the Team Authoring panel.

The Team Authoring panel displays your project folders and documents. The Doc-To-File project file
is displayed at the bottom.

You can perform the following functions from this panel:
n

Filter View Choose the file types that will be displayed in the Team Authoring window: Documents, Auxiliary Files, Only Pending Changes.

n

Refresh View Refresh the entire display to update the file status.
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n

Get Latest Version Get the latest version of the selected document from the repository. (TFS
projects include a drop-down that allow you to choose a specific version of a document.)

n

Check Out Check the selected document out of the repository.

n

Undo Pending Changes Undo all changes made to a document that has been checked out.

n

Check In Check the selected document into the repository.

n

Go Offline Break the connection with the server. You will be prompted to choose the project
editing mode: Restricted or Unrestricted. If you choose Restricted, an Unrestricted Project
Editing button will appear in the ribbon, allowing you to switch modes if you wish. This button
will toggle to Go Online while you are offline.

n

Compare (TFS projects only) Compare the selected document with the version on the server.

n

History (TFS projects only) View a history of the selected document's changes.

n

Open Open the file selected in the Team Authoring window for editing.

When you right-click on any of the files in this panel, you can select any of those options through
here. You can also toggle the option to Show Documents, Show Auxiliary Files, or Just Pending
Changes by selecting each one.
A check mark next to the file name indicates that it has been checked out. A lock icon indicates that
the file is part of the team project.
To change the column display, right-click in the window and from the menu choose Columns. The
options are:
n

Pending Change Displays file status. TFS projects have different status displays than File or
Web Repository projects. File or Web Repositories will note the check out status and the user
name, if a document has been modified and who modified it, if it is a new document, and if it is
unmodified by anyone. TFS projects will display the lock and edit status. The user name will
display in the User column.

n

User Shows the name of the user working with the file.

n

Latest Indicates whether the file displayed is the latest version.

n

Last Check-in Displays the date/time the file was last checked in.

The Team Log information displays for TFS projects only.
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Topics Window Panel (Word)
To make your Word source document more useful for online output, it is broken up into smaller elements called "topics," which are based on the heading styles in the document. After you create a
Doc-To-Help project and build some output from it, Doc-To-Help automatically creates multiple topics as a result, structuring the content for online documentation. Heading 1 styles in your Word document automatically become parent topics, and all of the Heading 2 styles under a Heading 1 style
become subtopics. Just keep in mind that these topics are not created until you build at least one
target in your project.
The Topics panel displays all of the topics that were created as a result of the most recent build.
There are several tasks you can perform in this window.
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DRAG-AND-DROP
From this window, you can select topics that can be dragged and dropped into the Contents, Index
and Groups, or Related Topics panes. You can also drag topics into source documents to create
links. See the online Help or the Documents, Templates, and Content Guide.
NOTE: You can also drag and drop topics from the Contents panel in the Doc-To-Help Project panel to create links in your source documents.

RIGHT-CLICK
You can right-click in the Topics panel and select several options, including the following:
n

Open Topic Open the source document and highlight the heading where the topic starts.

n

Show Filter Row Show/hide the filter row.

n

Clear Filter Clear the filter.

n

Show Deleted Topics Show/hide deleted topics.

n

Purge Deleted Topics Purge deleted topics.

n

Default Topic Specify a topic as the default for the project (the first displayed in the online output).

n

Remove Sort This will remove the option to sort the contents of a selected column alphabetically.

n

Reset Column Layout Return to the default column display.

n

Columns Specify the columns to display.

n

Copy Copy the selected row(s) in the Topics window.

n

Paste Paste the copied rows to the selected location in the Topics window.

n

Properties Open the Topic Properties dialog, which lets you choose various settings for the
topic. This includes the ability to apply platform, target, or attribute conditions to topics. See
the online Help or the Documents, Templates, and Content Guide.

ARRANGE COLUMNS AND SORT INFORMATION
Columns may be rearranged by selecting the column header and dragging to the desired position.
Click on a column header to sort by that column.
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LINKING TO DELETED TOPICS
If a particular topic has been deleted as a result of the latest build (e.g., it was conditioned out of the
target), it will be listed with a red X icon. Furthermore, in the Link dialog, you can create links to such
a deleted topic without first rebuilding a target that is conditioned to include it.
EXAMPLE
Let's say you place a condition on a topic called "References" so that it is included only
in a Manual target. When you build a NetHelp target, that topic is excluded from the output, and a red X is shown next to it in the Topics window.
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Then let's say you are working in a source document and you begin to insert a link. In
the Link dialog, you can see that the References topic has been removed as a result of
the most recent build. But you are still able to select this topic when linking to it, in anticipation of building the Manual target in the near future (where that topic will be
included).
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
On the Doc-To-Help Start Page, click the PDF Guides icon to access them.
Context-sensitive Help Guide

Shortcuts Guide

Documents, Templates, and Content Guide

Targets Guide

Getting Started Guide

Touring the Workspace Guide

Making It Look Good Guide

Upgrading Old Projects Guide

Managing Your Project Guide

What's New Guide

New User Tutorial Guide
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